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About This Document 
This document provides information related to software enhancements and application 

corrections for SedonaOffice after version 6.2.0.5. 
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Special Upgrade / Install Instructions 
If upgrading from a SedonaOffice version prior to 6.0, the following related updates are also 

required: 

FSU Updates - iOS devices must be on iOS version 11 or newer. Please also check the app 

store for any updates to your FSU app. 

SedonaWeb - If your company uses SedonaWeb, IT will update your SedonaWeb version at 

the same time as your SedonaOffice version.  This is to ensure the highest level of PCI 

compliance throughout all applications. 

SedonaCloud/SedonaAPI 2.0 Setup - If your company uses the SedonaAPI, IT will update 

your SedonaAPI version at the same time as your SedonaOffice version.  This is to ensure 

compatibility with the SalesAutomation module. 

If you are not a SedonaCloud customer, please review the requirements for the new API before 

requesting the update. For a copy of pre-install requirements, please 

contact: sedonaoffice.support@boldgroup.com 

Performing Update – For SedonaCloud customers, once you have reviewed all of the above 
information, and followed all preparation steps, contact SedonaOffice support.  We will note on 
your account that you have received the Release Notes and are ready for update.  
SedonaOffice IT will then contact you to schedule your update. 

Supported Environments 

Version Support 

**SedonaCloud Users** -  If your company utilizes SedonaCloud in any manner (utilize 

SalesAutomation, Time & Attendance, eForms, SedonaWeb 2.0, or the SedonaCloud API for 

integrations such as the Manitou integration), you will need to update your SedonaCloud to 

version 1.41.4.1 when you update SedonaOffice to 6.2.0.6. 

 

 

Minimum System Requirements 

Server is on Microsoft .Net 4.6.1 

  

mailto:sedonaoffice.support@boldgroup.com
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Enhancements / Features 

Service 

Custom Fields Available in Batch Billing 

On the Batch Billing grid within the SedonaSchedule, the ticket custom fields are now available 

to be added to the grid using the field chooser. 

Users will see these changes: 

 The custom tables tied to the service ticket have been added to the result grid. 

 The columns can be hidden when using the grid's field chooser tool. 

 The columns can be re-ordered. 

To be able to select ticket custom fields within the batch billing grid, the fields must first be setup 

in SedonaSetup. 
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Setup 

Navigate to SedonaSetup, and click on Custom fields Setup (Service).   

Activate the Custom Fields 

The fields that are activated will appear for data entry on the Ticket Custom Fields form, which 

is a tab on the Ticket.  Fields are activated by typing in a label in the text box to the right of the 

Custom Field that will be used.  The data saved in these fields may be used for reporting 

purposes. 

Here you may set up tables, which will provide the User with drop-down list of choices, money, 

text, date, or check box fields.  You may also define whether a field is required.  If a field is 

checked as required, the User creating a new Ticket or modifying an existing Ticket will be 

required to make a selection or enter information into all required fields.  You also have the 

option of defining what words will appear on the Custom Fields tab on the Service Ticket.  This 

is entered in the Label field at the top of this setup form. 

If you choose to set up Table type fields, you will need to set up the choices that will appear in 

the drop-down list for each field activated, in the Custom Fields Table 1 (Service) through 

Custom Fields Table 8 (Service). 
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Setup for Table Type Fields 

If any of the table type fields have been activated, setup the selectable choices for each 

activated table field. 

In our example below, we have defined the Table 1 field as “Cause Code”.  In the setup table, 

Custom Fields Table1 (Service) we have created a list of records from which the user may 

select. 
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Functionality 

To add any of the custom fields to the Batch Billing grid, follow the instructions below. 

1. From the SedonaOffice main menu, click on Service to launch the SedonaSchedule 

application. 

 

2. From SedonaSchedule, click on the View tab (upper left), and then click on the Batch 

Billing icon. 
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3. The Batch Billing grid will be displayed.  To be able to see more columns within the 

batch billing grid, click on the Show/Hide Calendar Bar button on the ribbon. 

 

 

4. At the upper left of the grid header row, click on the Field Chooser button. 
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5. A list of all available fields to display in the grid will be shown.  Check the box to the left 

of each field to display in the grid area.  When finished, click on the red “X” at the upper 

right of the Field Chooser to close the selection list. 
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Application Corrections 

Accounts Payable 

Discount Displays as Open Balance 

(17633) 

Issue: If a bill is created for a vendor and paid on the same date using a credit card, then the 

discount amount shows as an open balance. 

Solution: The software has been updated to support credit card payment on bills properly 

taking discounts, and properly updating bill net due and GL. 

Job Purchase Orders - Memo Field Clearing out Default 

Information 

(22495) [3975] 

Issue: The job number and phase default into the purchase order memo field, but then get auto 

removed when you click anywhere in the PO. 

Solution: There is now a check for vendor information in the memo field; if so, it will append 

with the job number and the phase number in the memo text. 

Vendor Journal Details are empty for Credit Card 

Discount (DISCT) 

(22558) [4603] 

Issue: The system errors if you try to take a discount on a bill you pay by credit card. If you do, 

the credit shows as applied to the bill, but there is no GL activity recorded for the application of 

this credit. Also, the bill shows a balance due of 0 in some places and shows the discount. 

Solution: This was corrected by pulling in the branch ID of the vendor if the branch ID was 

missing. 
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Recurring Bills list – Weekly Frequency 

(22604) [4432] 

Issue: Recurring Bills list: If the frequency is setup as weekly, the frequency column is blank in 

the list. 

Solution: Corrected the report to display the "Weekly" literal for recurring bills with a W as the 

frequency. 

Receipt not Correctly Displaying how PO was Received 

 (22789) [4404] 

Issue: In the Service Ticket PO, when selecting receive and issue immediately, the transaction 

was posting correctly. There was a display issue when viewing the receipt - it has the receive to 

warehouse radio button selected instead of the receive and issue immediately radio button. 

Solution: The program was changed to check if a service ticket number was filled in instead of 

a job number. 

PO Cannot be Received if Line is Received and then the 

Receipt is Deleted 

(24750) [26332] 

Issue: When editing and deleting PO receipts, the Lines deleted cannot be received again when 

added back to the receipt. Message is returned “You cannot receive more than what was 

ordered!” when you attempt to receive. The Purchase order shows quantity received is 0. 

Solution: Resolved by correcting the quantity received, which had been reset to 0 when adding 

the line to the receipt again. 

Close - No Bill Expected is Allowed Without a Write-Off 

No Bill Receipt Account Specified in Setup 

(25097) [38116] 

Issue: System is allowing users to mark receipts as “close no bill expected” even when there is 

no entry in the write off non-bill receipt setup field (GL Account Defaults for AP). The system 

used to prevent this. 

Solution: Added error check that blocks saving when the user selected the Close No Bill 

Expected checkbox on a receipt when the write off account has not been entered. 
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Material Handler Security 

(25803) 

Issue: When using the setting "Use Material Handler for Warehouse Security" and correctly 

setting up an employee to be a material handler, some of the warehouse dropdowns will default 

to a warehouse that should not be listed. 

Solution: When creating a New Purchase order, the default warehouse dropdown list value has 

been set to display the proper warehouse(s). 

PO Ship to Address where the Country = Other 

(26258) [4668] 

Issue: When changing a ship to address on a purchase order to the Country of Other, there 

were two issues: 1) the company field did not show; and 2) when entering information in all 

three lines and saving, only lines one and two would show. 

Solution: The first issue was corrected by changing a programing variable when changing the 

focus out of the country dropdown. The second issue was corrected by changing the 

programming value in a blank third line from empty to zero. 

Job Expense Type not Defaulted when Adding Bill from 

a Vendor  

(26496) [4207] 

Issue: Job expense type is not defaulting in the vendor bill when adding a bill through the 

vendor, but it does default if you add the bill through Accounts Payable. Adding a bill should 

work the same in both places. 

Solution: When creating a bill from Accounts Payable > Vendor > Bills, the Default Job 

Expense Type now shows, making it default the same way it does when creating a bill through 

Accounts Payable > Bills. 
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Accounts Receivable 

Print Invoice Process Loops  

(17520) 

Issue: When the Administrator user is trying to print cycle invoices the system appears to be 

looping. 

Solution: After opening the 'Preparing the Bridgestone Standard' or 'Preparing the Standard 

Form' window, there is now logic to hide the open window. 

Emailed Invoices Missing Site Name on Second Line 

Item 

(23843) [3395] 

Issue: When emailing invoices, using basic "Invoice Template", where there is more than one 

recurring line, sometimes the second and subsequent recurring lines are missing the site name. 

Solution: The Basic Template has been changed to display the same as the Advanced 

Template.  Instead of the Basic Template showing the name and address for each item on each 

line, the first line will show the site name and address once and then list all items for that site 

underneath it.  If there is a second site, the line will list the second site name and address once, 

and then list any line items for the second site underneath it. 

Site Address not Correct on Printed Invoice  

(23853) [24441] 

Issue: When creating an invoice and then changing the site address on the invoice, the invoice 

in SedonaOffice reflects the new site address, however when printing the invoice, it still shows 

the previous Site address. 

Solution: The program has been changed to properly use the changed site address when 

printing an invoice. 
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Run-time error 5 When Deleting Invoice Line Item on 

Subaccount 

(24766) [4516] 

Issue: Deleting an invoice item from an unsaved billable-to-master invoice will cause a Run-

time error that crashes Sedona Office. (There is no error if deleting an item from an invoice 

billed to the subaccount.) 

Solution: This is corrected so the system now pulls the list of items from an unsaved billable-to-

master invoice allowing a user to delete an invoice item. 

Clicking Customer Search Multiple Times after Saving 

Invoice does not Launch the Search 

(25067) 

Issue: After saving an invoice and remaining on the screen if you click search again the invoice 

header is updated and the invoice is incremented instead of launching the search. 

Solution: The search window will now open and a second search can be performed. 
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Client Management 

Credit Card Expiration Dates Changing to Incorrect Year 

(28587) [47363, 49236] 

Issue: Credit card expiration years are changing to the year 2020. 

Solution: This has been corrected by updating the program (the stored procedure) to accept a 

4-digit year. 

Customer Search not Remembering Filter Criteria  

(22077) [24439] 

Issue: Customer search does not save your search settings as it should. 

Solution: When the customer explorer is called from a modal, there was a default parameter 

being passed in as 0 (this defaults the search to start with "Begins With"). The default needed to 

be set to -1 (None) so the search retains the last setting; "Begins with", "Contains", or "Exact". 

Split Recurring Lines are Missing Information 

(22555) [4420] 

Issue: When splitting a recurring line, the new lines that are created have some blank fields 

(Description, Reference, and Memo). 

Solution: The process was updated to capture the original Description, Reference, and Memo 

on split items. 

Customer Explorer Sometimes Opens Wrong Company  

(22794) [27201] 

Issue: When the customer explorer is opened in one company; and then the company is closed 

and another company is opened.  When the customer explorer is opened again, it retains the 

old company that has been closed. 

Solution: When opening the customer explorer from client management, the customer explorer 

now shows information from the currently open company. 
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Sedona Event Log does not Record Contact Deletes 

(24341) 

Issue: Deletion of a Billing or Site contact does not record in the Sedona Event Log. 

Solution: Deleting a Billing or Site contact will now record the delete in the Sedona Event Log. 

System Custom Fields (Text Type) only allow 40 

characters - Should be 50 

(24767) [4414] 

Issue: The Text fields on the Custom Fields tab of the System record, is allowing only 40 

characters when it should be 50 characters. 

 

Solution: The database accepts 50 characters; the Text fields on the screen were expanded to 

enter the full 50 characters. 

AR Invoicing: Master Account Search Followed by 

Another Search  

(25490) 

Issue: When searching for a customer from AR Invoicing, select a customer that is a master 

account or sub account. Then immediately search for another customer that is not a master or 

sub account. The system treats this second customer as though it is a sub-account of the first 

selected master account. 

Solution: Logic changed to reset master account for a customer if the customer is not a master 

customer. 
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Inventory 

Cost Column Incorrectly Populates as 0 in Inventory 

Journal  

(22603) [4430] 

Issue: The cost column incorrectly populates as 0.00 in the inventory journal when you do a 

stock adjustment to reduce the on hand quantity. The extended cost and journal entry are 

correct, only the cost column in the inventory journal is incorrect. 

Solution: The cost entry has been corrected to properly show the cost when a stock adjustment 

reducing the quantity on hand has been made. 

Cannot Edit a Vendor from the Parts Explorer  

(22652) [4478] 

Issue: Once opening a vendor from the Parts Explorer and closing the vendor, users cannot 

open that same vendor again. 

Solution: The lock on the vendor table is deleted when users click the vendor again. 
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Job Management 

Job Part Price not Auto-filling 

(22586) [4270] 

Issue: When trying to add parts to a job under Tools > Issue Parts, the system will add the part, 

but the price is always 0.00. When adding it under the Job Materials, the system will add the 

correct price of the part. 

Solution: The program has been changed so that when adding parts using Tools > Issue Parts, 

the part price is added. 

Apostrophe in Job Type Causes Error  

(22587) [4280] 

Issue: If a Job Type Code contains an apostrophe, when access the job commissions tab, an 

error message is presented. 

Solution: The Job Type Code now allows an apostrophe. 

Job Timesheets Decimal  

(22630) [4689] 

Issue: When opening a previously saved Timesheet batch and clicking on the Units column to 

sort, any fractions of an hour disappear - hours only show whole numbers. 

Solution: Fractions in units no longer disappear when sorting by Units column in a previously 

saved timesheet list. 

Decimals Replaced by Whole Numbers in an Imported 

Timesheet Batch  

(26752) 

Issue: If a sort occurs before saving a newly imported timesheet batch (imported using .csv file), 

the decimals are replaced with whole numbers. It appears to round to the nearest whole number 

(whether up or down). 

 

Solution: Fixed the issue while importing data from a csv file in a Timesheet batch. 
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Service 

Open Job List and Schedule Board using Customer 

Group Security 

(22497) [4359] 

Issue: User Group Security Settings do not appear to carry through to the SedonaSchedule 

scheduling board for companies using Customer Group Security. Jobs that should be restricted 

and should not appear, are displayed in the Open Job list. 

Solution: The user group security settings now work correctly on the Schedule Board, so users 

see only the appropriate jobs. 
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Query Builders 

AP Query Builder Error -2147217900 the multi-part 

identifier "apcp.Credit_Id" count not be bound.  

(22602) [4413] 

Issue: When using credit parts fields, the AP query builder was generating -2147217900 sql 

error. 

Solution: Aliases in SD_Query_Builder_Def have been fixed to prevent errors. 

Customer Query Builder Missing Columns in 

Customer_Bill Table  

(23858) [25909] 

Issue: The Customer Query builder was missing some columns in the Customer_Bill table, 

which were introduced in a newer version of SedonaOffice, such as Email_Cycle_Invoice, 

Email_Job_Invoice, Email_Other_Invoice, and Email_Service_Invoice. The 

Customer_Bill_Email table is not captured at all.  

Solution: Added missing fields to Bill To and added Bill To Email to Customer Query Builder. 
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Report Manager 

Payments Received Report-Branch Name Sometimes is 

Incorrect  

(19476) [15298] 

Issue: When printing the Payments Received report, if a branch contains only a single payment, 

the branch on the Total line was different from the branch in the header. 

Solution: The report now displays the correct branch on the Total line, even if the branch only 

contains a single payment. 

Service ticket list report does not show resolved tickets  

(22434) [4635] 

Issue: Service ticket list report does not show resolved tickets. 

Solution: When selecting "Show All Open", all tickets with any status other than Closed will 

appear on the report. 

Accounting Ratios - Data is as of the 1st of the Month 

Instead of the last day of the Month  

(22930) [4212] 

Issue: The Accounting Ratios Report prompts for an accounting period, which indicates it is 

going to give the totals for that entire accounting period range.  When the report generates, it 

gives the totals as of the first day of the select accounting period. 

Solution: The report now shows end date of the selected accounting period 'As of'. 

Technician Schedule  

(24786) [4559] 

Issue: The "Technician Schedule" report uses the full name of the Site state, which cuts off the 

zip code on the report. 

Solution: The Technician Schedule Report was changed to use a field that has a two-character 

abbreviation for the state. 
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Technician Performance (Time)  

(26335) [40459] 

Issue: The Technician Performance (Time) report does not group correctly.  If grouping the 

report by Branch with a secondary grouping of technician, the report still only groups by 

technician. If grouping by Branch with a second group by of none, the report still only groups the 

report by technician. 

Solution: The report has been changed to implement grouping by branch in both first and 

second grouping. 

Customer Cancellations  

(26470) [36626] 

Issue: When the customer cancellations report is generated, the option for show branch labels 

can be selected. If this is selected the report still only shows one branch label. The customers 

cancelled in each branch show up, but they show up all under the one branch label. 

Solution: The report has been changed to show the customers under the correct branch labels. 

Year to Date Income Statement 

(26947) [19795] 

Issue: YTD income statement incorrectly gives monthly totals. If an account is 0.00 by the end 

of the month, the statement is not showing the activity for that month. 

Solution: The statement was changed to show activity for an account even if the account 

balance is 0.00 at the end of the month. 
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SedonaSetup 

Geographic Setup – Delete a Postal Code 

(21770) 

Issue: If a postal code cannot be deleted, the system does not give the user a message 

indicating why the record cannot be deleted. 

Solution: When a postal code cannot be deleted because it is in use, there is a new message 

"Postal Code in use. Cannot be deleted." 

Geographic Setup - Postal/Zip Code Not Visible 

(21780) 

Issue: Postal/Zip codes do not appear in the geographic table list if a service company or route 

is not defined on the record. 

Solution: Default the service company Id and route Id to 1, if none is selected when creating a 

new postal/zip code. 

Fixed the postal/zip code query, in SedonaOffice and Sedona Tables, so that it will retrieve 

codes with 0 service company Id or route Id. 

Custom Fields (Service) Tables  

(21971) 

Issue: The Custom Fields (Service) Table grids show inactive entries if the Include Inactive 

check box is de-selected. 

Solution: The Setup Table was changed to correct this so that inactive entries are shown only 

when the Include Inactive check box is selected. 

Document Type 

(22489) [27247] 

Issue: Deleting SY_Document_Type records from the front-end under SedonaSetup>Document 

Types causes orphaned document records across several other SedonaDocuments data tables. 

Solution: The program was changed to allow users to delete a document type only if there are 

no documents actively using that type. 
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Sales Automation 

Proposal Email Subject not Displaying Proposal Number  

(26642) [37536] 

Issue: Proposal emails sent to end customers do not include the Proposal number in the email 

body or subject 

Solution: Proposal emails sent to customers now include the proposal number in email subject 

line. 

Receiving Signed eForm allows Bypass of Proposal 

Approval  

(17011) [5242, 16461, 28970, 38266] 

Issue: Only creators of the proposal have to go through submit for approval process. 

Solution: If proposal approval rules have been configured in SalesAutomation, a signed eForm 

attached to an open proposal will not allow the proposal to be completed if that proposal still 

requires approval per the configured approval rules. 

Proposals – Users able to Bypass Approval Process  

(22585) [29400, 34810] 

Issue: Users can bypass the approval process and mark a proposal as sold without going 

through the proper steps. 

Solution: This has been resolved so that when a user saves a proposal, the proposal approval 

rules will be re-evaluated and will not allow the proposal to be saved with a 'Sold' or 'Accepted' 

status if the proposal changes triggered the proposal approval required flag. 

Discount Amount Instead of % not Updated when Sales 

Package is Changed 

(26262) [35829] 

Issue: If a user changes the sales package on a proposal, and the proposal is using a discount 

amount instead of %, that discount will not update properly when the sales package is changed. 

Solution: This has been resolved to ensure both Discount Amount and Discount % values are 

updated when changing Sales Packages in the proposal edit view. 

 


